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Notice

Copyright

Trademarks

Ordering
information

WEEE Directive
Compliance

Every effort was made to ensure that the information in this document
was accurate at the time of printing. However, information is subject to
change without notice, and JDSU reserves the right to provide an
addendum to this document with information not available at the time that
this document was created.

© Copyright 20011 JDSU, LLC. All rights reserved. JDSU, Enabling
Broadband and Optical Innovation, and its logo are trademarks of JDSU,
LLC. All other trademarks and registered trademarks are the property of
their respective owners. No part of this guide may be reproduced or
transmitted electronically or otherwise without written permission of the
publisher.

JDSU and MTS/T-BERD 2000 are trademarks or registered trademarks
of JDSU in the United States and/or other countries.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet
Explorer are either trademarks or registered trademarks of Microsoft
Corporation in the United States and/or other countries.

Netscape Navigator is a trademark or registered trademark of Netscape
Communications Corporation in the United States and other countries.

Specifications, terms, and conditions are subject to change without
notice. All trademarks and registered trademarks are the property of their
respective companies.

This guide is a product of JDSU's Technical Information Development
Department, issued as part of the User Manual. The ordering number for
a published guide is E2000M02.

JDSU has established processes in compliance with the Waste Electrical
and Electronic Equipment (WEEE) Directive, 2002/96/EC.

This product should not be disposed of as unsorted municipal waste and
should be collected separately and disposed of according to your
national regulations. In the European Union, all equipment purchased
from JDSU after 2005-08-13 can be returned for disposal at the end of
its useful life. JDSU will ensure that all waste equipment returned is
reused, recycled, or disposed of in an environmentally friendly manner,
and in compliance with all applicable national and international waste
legislation.
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It is the responsibility of the equipment owner to return the equipment to
JDSU for appropriate disposal. If the equipment was imported by a
reseller whose name or logo is marked on the equipment, then the owner
should return the equipment directly to the reseller.
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About This Guide

The 2000 Platform of JDSU provides a handhled modular platform
designed for the construction, turn-up and maintenance of fiber
networks.

The topics discussed in this chapter are as follows:

“Purpose and scope” on page xvi
“Assumptions” on page xvi
“Technical assistance” on page xvi
“Conventions” on page xvii
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About This Guide
Purpose and scope

Purpose and scope

The purpose of this guide is to help you successfully use the 2000 Plat-
form features and capabilities. This guide includes task-based instruc-
tions that describe how to install, configure, use, and troubleshoot the
2000 Platform.

Additionally, this guide provides a complete description of JDSU’s
warranty, services, and repair information, including terms and condi-
tions of the licensing agreement.

Assumptions

This guide is intended for novice, intermediate, and experienced users
who want to use the 2000 Platform effectively and efficiently. We are
assuming that you have basic computer and mouse/track ball experience
and are familiar with basic telecommunication concepts and terminology.

Technical assistance

If you need assistance or have questions related to the use of this
product, call or e-mail JDSU’s Technical Assistance Center for customer
support.

Table 1 Technical assistance centers

Region

Phone Number

Americas

Telecom Products

Europe, Africa, and

Mid-East

866 228 3762 tac@jdsu.com

World Wide: 301 353 1550

+49 (0) 7121 86 1345 hotline.europe@jdsu.com
(Europe)

+33 (0) 1 30 81 50 60 support.france@jdsu.com

(JDSU France)

Asia and the Pacific

+852 2892 0990

Southeast Asia, Aus- (Hong Kong)

tralia, and New Zea-

land

All others

+86 10 6833 7477
(Beijing-China)

866 228 3762 tac@jdsu.com

XVi
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About This Guide
Conventions

During off-hours, you can request assistance by doing one of the

following:

— leave a voice mail message at the Technical Assistance number in

your region

— e-mail North American Technical Assistance Center, tac@jdsu.com,
or European Technical Assistance Center, support.uk@jdsu.com

— submit your question using our online Technical Assistance Request

form at www.jdsu.com.

Conventions

This guide uses naming conventions and symbols, as described in the

following tables.

Table 2

Typographical conventions

Description

Example

User interface actions appearin
this typeface.

Buttons or switches that you
press on a unit appear in this
TYPEFACE.

Code and output messages
appear in this typeface.

Text you must type exactly as
shown appears in this type-
face.

Variables appear in this type-
face.

Book references appear in this
typeface.

A vertical bar | means “or”: only
one option can appear in a sin-
gle command.

Square brackets [ ] indicate an
optional argument.

Slanted brackets < > group
required arguments.

On the Status bar, click Start.

Press the ON switch.

All results okay

Type: a:\set.exe in the dia-
log box

Type the new hostname
Refer to Newton’s Telecom
Dictionary

platform [al|ble]

login [platform name]

<password>
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About This Guide
Conventions

| > B

>

> P

xviii

Table 3 Keyboard and menu conventions
Description Example
A plus sign + indicates simulta- Press Ctrl+s

neous keystrokes.

A comma indicates consecutive Press Alt+f,s
key strokes.

A slanted bracket indicates On the menu bar, click
choosing a submenu from Start > Program Files.
menu.

Table 4 Symbol conventions

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

NOTE

This symbol represents a Note indicating related information or tip.

This symbol, located on the equipment or its packaging
indicates that the equipment must not be disposed of in a land-
fill site or as municipal waste, and should be disposed of
according to your national regulations.

Table 5 Safety definitions

WARNING

Indicates a potentially hazardous situation which, if not avoided, could
result in death or serious injury.

CAUTION

Indicates a potentially hazardous situation which, if not avoided, may
result in minor or moderate injury.
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2000 Platform Overview

This chapter provides a general description of the 2000 Platform.

Topics discussed in this chapter include the following:

— “Unpacking the instrument” on page 2
— “About the 2000 Platform” on page 2
— “Main features” on page 3

— “Hard keys and Indicators” on page 5
— “Power Supply” on page 7
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Chapter 1 2000 Platform Overview
Unpacking the instrument

Unpacking the instrument

1 Remove the 2000 Platform and its accessories from the packing
case.

2 Check that the module and accessories ordered are all there.

If any part is missing or damaged please contact your local JDSU agent.
The 2000 Platform is delivered as standard with:

Table 1 Elements delivered on standard with the 2000 Platform

A Getting Started Manual

A Li-Polymer battery, set into the equipment and which must be
charged before use

A mains adapter used for mains operation of the instrument and
battery charging

5 country adaptable plugs (Europe / UK / US / Australia / Japan)
A hands-free soft case for the 2000 Platform
A USB cable, to directly connect the 2000 Platform to a PC

A shoulder strap

About the 2000 Platform

The architecture of the 2000 Platform is made of one Platform, to which
a module can be added to perform tests on fiber networks.

The modules that can be fitted to the 2000 Platform are interchangebale
in the field and different kinds of module are usable:

— OTDR Modules

— PON Selective Power Meter (OLP)

— CWDM Analyzer Modules (C-OSA)

The 2000 Platform employs multi-tasking for the simultaneous perfor-
mance of several operations:

— acquisitions

— modifications of parameters

— ftrace analysis

— report management

2 User Manual 790000002/00



Chapter 1 2000 Platform Overview
Main features

It also allows to use simultaneously several functions:

Power Meter
Scope
OTDR measurements...

Main features

The 2000 Platform is equipped with the following elements:

A 5inch TFT color touchscreen, high visibility
RJ45 plug for Ethernet interface

Two USB 2.0 host connectors for Microscope, USB memory stick,
mouse, keyboard, ...

One mini USB 2.0 device connector to connect the 2000 Platform to
aPC

An audio jack to connect a headset

A connection socket for the mains adapter providing the 12 V power
supply and used to charge the battery.

LED indicators for Charge, On status and Test

A Li-Polymer battery

A module interchangeable in the field: OTDR, OLP, or C-OSA.
Built-in Power Meter, VFL and/or Talkset (options)

With the 2000 Platform, the user can:

Open and/or transfer files to a PC via a USB memory stick, USB
cable or Bluetooth (option)

Generate pdf reports
Open all user documentations included into the 2000 Platform
Update the 2000 Platform firmware

Remote the screen of the 2000 Platform onto a PC and issue
commands from the keyboard of the PC
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Chapter 1 2000 Platform Overview
Main features

Fig. 1 2000 Platform with module

TFT 5” Color
Touchscreen

R A

Indicators N o> @%} = P
9 (= Loudspeaker

Hardkeys IO

[P =
"k@;l

RJ45 USB host Power Meter VFL MiniUSB AC/DC  Headsetjack
device Input
Fig. 3 2000 Platform: Connectors View
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Chapter 1 2000 Platform Overview
Hard keys and Indicators

Hard keys and Indicators

Front panel
hard keys

Fig. 4 Hard keys and Indicators
Table 2 Hard keys description

Hardk Function

Main on/off switch

This button calls up the file explorer. It allows to:

— choose the storage medium: internal memory, USB
memory key..

— manage files; with facilities for classifying them in direc-
tories and sub-directories.
Gives access to:
— selection of the different measurement or functions
— the settings of the instrument
— the help page

This menu depends on the function in use.

This button allows to deselect a function or escape a
menu

Starts and stops the measurement.

This button calls up the results page (e.g. with OTDR
module: reflectometry trace and table of results).

ey
@ This button calls up the measurement configuration menu.
J
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Chapter 1 2000 Platform Overview
Hard keys and Indicators

NOTE

All these functions, except HOME, depend on the modules used and
the measurements made: refer to the user manuals of the corre-
sponding modules of the 2000 Platform.

The direction keys have two principal functions:

— on the Results page, they are used to move the cursors or
modify the zoom factor.

— on the set-up pages, they are used to scroll through the
menus, the central button serving to select or confirm the
parameter chosen.

Front panel The 2000 Platform is equipped with three indicators, lit into a different
indicators color acccording to the status of the unit.

Table 3

Indicators Status

On indicator
On

O Blicking green

On ,
O Solid green

The instrument, though connected to an
external power source, is switched off.

The instrument is operating, either by battery
or on an external power supply.

Charge indicator

Charge

O

Charge
7=, Solid red
o

Solid green

The instrument is connected to an external
power source and the battery is fully
charged.

The instrument is connected to an external
power source, and the battery is on charge.

Testing indicator

Solid red

Testing
@)

At least one function is in measurement
phase (for example, the laser emission pilot
for an OTDR measurement)

6 User Manual
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Chapter 1 2000 Platform Overview
Power Supply

Power Supply
The 2000 Platform may operate with
— the Li-Polymer battery, already set into the equipment on delivery.
— an AC adapter/charger, via a power cable on which has been set the
correct country adaptable plug.
1_[_ Power supply plug -
U —Thoa e P mall|
Interchangeable plugs
L | i
UK adaptable plug EUROPE us JAPAN AUSTRALIA

(installed by default) adaptable plug adaptable plug adaptable plug adaptable plug

Fig. 5 Delivered elements for 2000 Platform supplying
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Power Supply
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Safety information

This chapter gives the main information on the safety conditions when
using the 2000 Platform:

“Battery and AC/DC safety information” on page 10
“Precautions relating to optical connections” on page 10
“Laser Safety instructions” on page 11
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Chapter 2 Safety information
Battery and AC/DC safety information

Battery and AC/DC safety information

— The Li-Polymer battery is designed for maximum safety.

In particular, each cell is provided with a safety valve to prevent exces-
sive internal pressure in the event of overcharging or exposure to very
high temperatures.

— Battery supplied by JDSU incorporate protection means.

Do not use any mains adaptor or battery other than those supplied with
the instrument, or supplied by JDSU as an option for this instrument.

If another adapter or battery is used, it may damage the 2000 Platform
itself.

Using the 2000 Platform with a battery other than the one supplied by the
manufacturer of the 2000 Platform may entail risks of fire or explosion.

The battery may explode, leak or catch fire:

— ifitis exposed to high temperature or fire
— if it is opened or dismantled.

Other basic safety precautions are as follows:

— Do not use AC/Adapter/Charger outdoors or in wet or damp loca-
tions

— Connect the AC/Adapter/Charger to the correct mains voltage, as
indicated on the ratings label.

— Do not allow anything to rest on the power cord, and do not locate
the product where people can walk on the power cord.

— Avoid using this product during an electrical storm. There may be a
remote risk of electric chock from lightning.

— Do not use this product in the vicinity of a gas leak or in any explo-
sive environment.

— Do not attempt to service this product yourself, as opening or
removing covers may expose you to dangerous, high voltage points
and other hazards. Contact qualified service personnel for all
service.

Precautions relating to optical connections

10

— The normal operating life of an optical connector is usually of the
order of a few hundred manipulations. It is then advisable to manip-
ulate the optical connections of the Platform as rarely as possible.

— The proper operation of the instrument and its accuracy of measure-
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Chapter 2 Safety information
Laser Safety instructions

ment are dependent on the cleanliness of the environment and the
optical connectors as well as the care taken in its manipulation.

— The optical connectors must therefore be clean and dust-free. If the
optical connection is not being used, protect the connections of
2000 Platform using the protective caps.

Laser Safety instructions

Laser classes

Warning labels
for the laser
classes

A\

The provisions contained in two standards define the safety procedures
to be observed both by users and by manufacturers when utilizing laser
products:

— EN60825-1: 2001 - Safety of laser products — Part 1: Classification
of products, requirements and user guidelines.

— FDA 21 CFR § 1040.10 - Performance standards for light-emitting
products - Laser products.

Due to the range of possible wavelengths, power values and injection
characteristics of a laser beam, the risks inherent in its usage vary. The
laser classes form groups representing different safety thresholds.

Standards EN 60825-1, Edition 1.2, 2001-08 and FDA21CFR§1040.10:
— VFL option: Class 2.

Due to the reduced dimensions of the optical modules, it is not possible
to attach the required warning labels to them. In line with the provisions
of Article 5.1 of the EN 60825-1 standard, the laser class identification
labels are shown below:

Reference | £ 60g25-1, Edition 1.2, 2001-08 | FDA21CFR§1040.10
standard

Class 1 CLASS 1

Class 2

LASER RADIATION
DO NOT STARE INTO BEAM
CLASS 2 LASER PRODUCT

LASER RADIATION - DO
NOT STARE INTO BEAM

CLASS II LASER PRODUCT

The user must take the necessary precautions concerning the optical
output of the instrument and follow the manufacturer’s instructions.

Measurements on optical fibers are difficult to execute and the
precision of the results obtained depends largely on the
precautions taken by the user.
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Chapter 2 Safety information
Laser Safety instructions
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Starting up

This chapter describes the first steps to perform when using the 2000
Platform.

The topics discussed in this chapter are as follows:

“Fitting and removing a module” on page 14

“Setting the adaptable plug to the mains adapter” on page 15
“Charging the battery” on page 16

“Switching the 2000 Platform on and off” on page 17

“First start: configuring your regional settings” on page 18
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Chapter 3 Starting up
Fitting and removing a module

Fitting and removing a module

The 2000 Platform must be switched off, and if it is operating on
A the mains, its supply cable must be unplugged.

Fittinga 1 Turn the instrument face down on the work surface.

module 2 Set the two notches on the module part (1a) into the two holes
provided for that purpose on the Base (1b).

3 Make flush the 2 connections (2a & 2b), on module and base.

4 Once positioned, fix the module to the base screwing the 2 screws
(3a) fixing the receptacle.

X latfo
With m
e U mogy
/\. \/f
- '
4 //ﬁ = '{" ull:.-:‘_.__._. |I
C . W
QW‘L’L o
3 e T ),
_.--.-' '-'-::,.___ e "; - 2000
— s Orrn
— — w
f!____, == dUIe ’”Sl‘al/e th

Removing a 1 Unscrew the two captive fixing screws of the module completely (up

module to the stop).
2 Remove the two slots of the module from their housing onto the
base.

3 Carefully remove the module out of its slot.
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Chapter 3 Starting up
Setting the adaptable plug to the mains adapter

Setting the adaptable plug to the mains adapter

The 2000 Platform is supplied as standard with a mains adapter and 5
country adaptable plugs (Europe / UK/ US / Australia/Japan).

To set the correct plug to the mains adapter:

1 Make flush the connector onto the mains adapter with the adaptable
plug slots.

2 Push the adaptable plug until it stops.

[
.
.
|
X .
IS, TN
&g, -
X 3 .-c-*"'f -~
S
#_,.-'"
A
2 3
1 .
|
i
==
Fig. 7 Setting the adaptable plug onto the mains adapter

If the adapter plug is not correctly set onto the mains adapter,
& the connector may be damaged.
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Chapter 3 Starting up
Charging the battery

Charging the battery

Connecting the 1 setthe appropriate adaptable plug to the power supply cable,
mains adapter according to your country (see page 15).
2 Atthe right side of the 2000 Platform, lift up the power supply socket
protector and plug in the mains adapter.

3 Connect the adapter to the mains.
The On indicator lamp starts to blink in green.

adapter for some other electronic device may appear to be

Use only the mains adapter supplied with the 2000 Platform. The
A identical, but entails a risk of damage to the 2000 Platform.

First use of the Atthe delivery, the battery is already set into the Platform, but its charge
battery level is not «recognized» by the equipment.

The icon @ is displayed on the upper banner of the screen.

To get a valid indication of the battery, and be able to use correctly the
Platform:
1 Charge fully the battery

2 Once fully charged, discharge the battery by keeping the Platform
switched on, but not plugged to mains.

3 The battery can then be charged, and the Platform used simultane-
ously.

Charging the 0On connection to the mains:

battery — ifthe user does not press ON, the battery will start the charge. In this
case, the Charge indicator will be lit in red.

— when the user presses the ON key, the instrument starts up and the
battery will charge during use (Charge indicator in solid red).

Once the battery is fully charged, the Charge indicator is lit in solid green.

When the Charge indicator is blinking red, this mean the power supply is
not compatible with the battery used. Charge is disabled.

It is essential to wait until charging is complete to ensure
& maximum independent operating time, which may otherwise be

considerably reduced.
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Switching the 2000 Platform on and off

Battery If the battery is completely discharged, the time taken to recharge is:
charglng time _ approximately 3.5 hours, if the apparatus is not in use (Charge indi-
cator solid red)

— about 9.5 hours if the instrument is used during charging (On indi-
cator lit in fix green, Charge indicator lit in solid red).

Battery charge When the battery is installed in the instrument, a battery icon is displayed
level display in the top right-hand corner of the screen. Example:D.

Table 4 Battery icons

The battery capacity is superior to 75%

The battery capacity is set between 50% and 75%

The battery capacity is set between 25% and 50%

The battery capacity is inferior to 25%

The battery capacity is unknown. Perform a full charge/
discharge of the battery to get back to a valid indication.
This icon may appear if battery is changed or if the bat-
tery auto discharges at a very low level (example: if a
Platform switches off as battery is empty, and the charge
is not done during several months (= auto discharge)).

d 0088

— When the level becomes too low, the instrument emits a beep ton
inform the user until it switches off automatically after saving the
current configuration and measurement.

Switching the 2000 Platform on and off

Switching on 1 Press the ON/OFF key.
the 2000 If the Platform is powered to mains, the battery will charge.
Platform The On indicator pass from blinking to solid green.
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Chapter 3 Starting up
First start: configuring your regional settings

The JDSU logo appears on the screen briefly, then an autotest is
carried out.

The equipment is ready to be used once all the applications are
installed.

s | NOTE

It is possible to switch over from battery to mains operation, or vice
versa, without loss of data.

The module cannot be swapped when the unit is ON or AC
powered

battery, the current results and configuration will not be saved.
Next time the instrument is switched on, it will return to its initial
configuration.

j In the event of an unexpected mains power cut, if there is no

Switching off while the 2000 Platform is operating, press the ON/OFF button to switch
the 2000 itoff.

Platform
s NOTE

When the instrument is switched off using the ON/OFF button, current
results and configuration are saved. Next time the ON/OFF key is
pressed, they are recalled.

Resetting the Ifthe 2000 Platform freezes, prolonged pressure (about 4 s.) on the ON/
2000 Platform OFF key will reset the instrument.

First start: configuring your regional settings

Once the 2000 Platform is switched on, the first screen displayed allows
to configure the regional settings.

Those settings will be kept in memory and automatically applied on the
instrument each time it is restarted.

18 User Manual 790000002/00
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First start: configuring your regional settings

= System Setfings T B4 11 SR
Language English  Francas | Engiish O
Date DE/152011  Dwutsch Espanol
Tirme 09:11 Eakano Portuguese
Date format mm/defyyyy | Trad Chinese | Simp Chinesa
Time format 24 hour clock | japaneie Russian
Korean | Turkish
Swdish | _h!ﬂrwrglan
Czech | ENGLISH CAPS
HMungarian | Polish
finnlsh | Danish
ViMnamess ET""""'
[0
b |
Exkt
al
Fig. 8 Regional Settings
1 Click on Language and select the language to be used for the
equipment.
2 Click on Date and enter the current date, using the numeric keypad
displayed using the menu key Edit Number.
3 Click on Time and enter the current time, using the numeric keypad
displayed using the menu key Edit Number.
The date and time are displayed on the upper right side of the
screen.
4 Click on Date Time Format and configure the following parameters:
— Date format: select one of the option dd/mm/yy or mm/ddlyy.
— Time format: select one of the option 24 hour clock or 12 hour
clock.
5 Once all parameters have been defined, press Exit menu key.S to

reach the System Settings page.
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First start: configuring your regional settings
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Configuring the 2000 Platform

This chapter describes the operations for configuring the instrument.

The topics discussed in this chapter are as follows:

“Displaying the System Settings screen” on page 22

“Defining the screen parameters of the 2000 Platform” on page 23
“Defining the Audio parameters of the 2000 Platform” on page 24
“Defining the Automatic shutdown of the 2000 Platform” on page 24
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Displaying the System Settings screen

Displaying the System Settings screen

To display the System Settings screen, you must:

1 Press the HOME hard key to reach the Home page.

] [ T

& Hioma
4 - W
AN T

N K x e

INFIAT OTDE BHART OTDR  ROUMCT  FOWIRMETES

Fig. 9 Home page
2 Activate the Settings icon . ' to open the System Settings
screen. [r—
B Gistem Seltings [ - T lT &R0
I Screen O iy
Backlight &0 Hode Scresnshot W
Contrast Indocs File Farmat PRG Raglonal
SLraadn Saver L RT3 ‘iﬂ'._lﬂl;n-
y
EEhernet L
Akietooth Disasble
Py -
Upgrade Paramaters - Eﬁn
™ ¥
[ racds -l ke B Exit
Heaclsat Wolume (1] N
" -

Fig. 10 System Settings page

m NOTE

If you are in the Regional Settings page, and you press Exit, then the
System Settings page automatically displays.
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Chapter 4 Configuring the 2000 Platform
Defining the screen parameters of the 2000 Platform

Defining the screen parameters of the 2000 Platform

In the System Settings page, the following parameters can be defined:

Backlight 1 click on Backlight
2 Define the backlight level of the screen, using the left and right
direction keys, or clicking on Edit Number softkey and using the
keypad displayed.
— Min backlight level: -5
— Max backlight level: +5

choose a minimum lighting level, acceptable for the user, to keep

If the 2000 Platform is operating on battery, it is advisable to
& endurance as long as possible.

Contrast 1 Click on Contrast
2 Select the type of environment into which the instrument is used:
— Indoor: to be selected when the instrument is used inside (see
Figure 10 on page 22)

— Outdoor: to be selected in order to optimize the readability of
the screen for an outside use.

Fig. 11 Example of outdoor contrast

Screen Saver Click on Screen Save if you wish to activate a screen saver to the equip-
ment, to extend the life of the battery, in case the 2000 Platform is not
used for some time.

Instead of the normal screen, a small animated picture of the 2000 Plat-
form is displayed on the blackened screen.

User Manual 790000002/00 23



Chapter 4 Configuring the 2000 Platform
Defining the Audio parameters of the 2000 Platform

To configure the screen saver:

1 Click on Delay and select the time of inactivity before e

the screen saver starts: 60s, 3 min, 5 min. 00 Basn Uit

13:71:11

The parameter No deactivates the screen saver func-
tion.

Defining the Audio parameters of the 2000 Platform

In the Audio box of the System Settings screen, you can configure the
audio parameters according you are using a headset with the 2000 Plat-
form.

1 Adjust the volume on the line Hands-free Volume using the left and
right direction keys, or the Numeric keypad (displayed with the
softkey Edit Number)

— Min volume for Hands-free function: 0
— Max volume for Hands-free function: 100

2 If aheadset is used, adjust the volume on the line Headset Volume,
using the left and right direction keys, or the Numeric keypad
(displayed with the softkey Edit Number):

— Min volume for Headset function: 0
— Maxvolume for Headset function: 100

Defining the Automatic shutdown of the 2000 Platform

24

The automatic shutdown function switches off the 2000 Platform auto-
matically if no operation has been performed and no key actuated for a
period selected from this menu. Work in progress is automatically saved.

The function for automatically switching off the 2000 Platform is
& available only on battery operation, to save the battery.

In the Utility box, click on Auto off parameter.

2 Choose a time after which the 2000 Platform will be switched off
automatically, if no action has been done for that period: 5, 10 or 30
minutes.

Select No if the 2000 Platform must not be switched off, even if there is
inactivity on the equipment.
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Power meter, VFL (Visual
Fault Locator) & Talkset

A variety of built-in optical options are available when ordering. See
references in Chapter 10 “Options and accessories”, for details.

The topics discussed in this chapter are as follows:

“Connection to the power meter, VFL and Talkset” on page 26
“Using the Power meter” on page 26

“VFL Function” on page 31

“Storing and reloading results” on page 32

“Talkset Function” on page 33
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Chapter 5 Power meter, VFL (Visual Fault Locator) & Talkset
Connection to the power meter, VFL and Talkset

Connection to the power meter, VFL and Talkset

| r—ﬁﬂ\\;_:';r-r _‘._:-.-_ L=
¥, ~ . Power meter
H%r:“ "\. —_— = ' optical connection
| | — 1= =
:_.; I.-..".'a H] H [

Fig. 12 Optical connectors

The type of optical connector used for the power meter is UPP (Universal
Push Pull), which is compatible with all diameter 2.5 mm connectors (FC,
SC, ST, DIN, E2000, etc.)

Accuracy of measurements
A A high degree of accuracy is often required. It is then necessary to

perform a preliminary calibration without the fiber under test to elimi-
nate the losses due to connections as far as this is possible. To do
this, use the «Reference Value» function.

Using the Power meter

The power meter function is an option chosen at the time of order and
incorporated into the 2000 Platform in the factory.

To activate the function:

Press the HOME button
2 Activate the power meter icon of the Platform

The effect of this action will to be to bring the power meter into use
and to display the Results page for Power Meter.

Configuring the
power meter

Configuring The measurement parameters can be accessed with the SETUP key.
measurement
parameters
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Chapter 5 Power meter, VFL (Visual Fault Locator) & Talkset

L
Wiweslasgth

(Mwep on modulsion

Unit

Using the Power meter

L300 nm | Auts | E30 nm | 09 nm | 1300 mm 1310 nm
1 | 1410 Am | B45D Am | L4AG mes Jllﬂﬂnilliﬂhm
Yeu (1530 nm| 1625 nm|  deer
n

Raference Lol E T
Aftesustor compensation 0.0 dB
T
.l];;nl Rilive
IHn Threnhaid g 2] ﬂ‘m.
Mo Threshald ~do dnm|
Fig. 13 Configuration of power measurement
Wavelength Selecting wavelength:
- Auto: the wavelength of the input signal will be
automatically detected and selected to perform
the measurement:
850, 980, 1300, 1310, 1420, 1450, 1480, 1490,
1510, 1550 or 1625 nm: measurement performed
at specified wavelength.
- User: choice of wavelength on the next line
User choice (if the User option was selected in the Lambda

Beep on Modulation

Unit

Reference level

line) enter the wavelength between 800 and
1650 nm, using the numeric keypad, displayed
via the Edit Value key..

Select if a sound must be heard when a
modulation occurs (Yes / No)

Unit of power displayed:
- Watt, dBm for displaying absolute power

- dB for displaying a result relative to a reference
(link loss)

If dB units were chosen in the previous line,
selection of the reference value for the
wavelength selected. First select the wavelength,
then press the > key to access choice of the
value (+XXX.XX).

This reference is also automatically available, in
the Results page, using the Set as Reference
key.

Attenuator compensation

Choice of level to be applied to the wavelength
chosen for measurement to compensate for the
loss due to the external attenuator (+XX.XX dB).
First use the direction keys to choose the
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Using the Power meter

wavelength, then press > to access choice of
value.
mmmmm NOTE

To copy a Reference Level or a Attenuator Compensator on all wave-
lengths, select the reference wavelength and click on Update for All

Wavel..
Configuring the Alarm Activation of the Alarm function : any result below
alarm parameters the lower threshold or above the upper threshold
of the power meter will be displayed in red on the Results page.

Min and max thresholds :

Choice of lower and upper thresholds for each
available wavelength, from -60 to +40 dBm
(selected with the direction keys).

mm NOTE

To copy one value of the Lower or/and Upper threshold for all wave-
lengths, select the reference value and click on Update for All
Wavel..

m— NOTE
A continuous push on direction keys increments the value by 10 dBm.

Display of The results page called up by the RESULTS button, gives the information
results and relating to the measurement in progress, results previously saved and
the commands available for measurement and saving.
commands

Result of the The power measured by the power meter is displayed in large charac-
measurement in ters, in the units selected in the SETUP menu, together with:
progress _ e mode of transmission of the signal measured: continuous (CW)
or modulated to a frequency of 270Hz, 330Hz, 1KHz, or 2KHz.
— the wavelength of the signal measured.
— the reference level expressed in dB.

— the level of Attenuation Compensation.

Table of results For one and the same fiber, the power meter displays a table of 9 results
corresponding to the different possible wavelengths. The first 4 results
are displayed on the screen; to scroll through the other results, use the
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Commands of the
power meter
parameters

Chapter 5 Power meter, VFL (Visual Fault Locator) & Talkset
Using the Power meter

direction key W . The table shows the power measured in dBm, the rela-
tive power (in dB) and the reference level in dBm (if units = dB), together
with the mode.

— A measurement result is displayed in the table when the Keep
Result softkey is pressed.

— The Clear Table softkey orders deletion of all the results displayed
in the table.

— Ifthe Alarm function has been activated, any result that exceeds the
selected thresholds appears in red in the table. Otherwise, results
are shown in the table in green.

— When the instrument is switched off, results present in the table are

saved.
[y ::ﬂ":;
4827, | =
1310nm [ dB Rt
Results Helerece Lavel . +1.0.d0
of the L or
power meter| s iy ::':_ mu:-‘rtm i ',f,.".” ":'_“ j Hx"":;L
Fig. 14 Results and commands of the power meter

When the LTS function is selected, the following softkeys are available
on the results page:

Keep Result Saves the result on the corresponding line of the
table.
Clear Table Deletes all the results recorded in the table.

Pressing the Powermeter Config. key allows to reach the following
function:

Wavelength Allows to modify the wavelength to be applied
with the Power meter.

Unit Allows to modify the unit of power displayed (dB,
dBm, nW)

Zero Adjustment of the Zero value when the power

meter’s optical input is closed with a plug (a
validation is required).

Click on Exit to go back to the Results page.

Pressing the Pow. Reference key allows to reach the following function:
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Using the Power meter

Standard Reference Selects the current result as reference value to
measure the attenuation of a link. This reference
is displayed under the measurement result until a
new reference value is chosen.

Jumper Reference This key can be pressed when a reference in
loopback mode must be performed (see 2100
Module Series User Manual).

activated if both power meter and Source are selected onto the
OTDR Module set into the Platform.

The power meter must be selected onto the Base-Unit, and the
Source onto the OTDR Module to activate the soft key and be
able to perform a reference measurement in loopback mode.

j The soft key Jumper Ref is displayed in grey and cannot be

Performing A The power meter is started up as soon as the function | %= N is acti-
measurement vated in the HOME menu. m

Power measurement is automatically updated in consequence. The
& value «<-60 dB» is displayed when the laser is switched off and if the

source output is looped on to the power meter input.

Power 1 Connect the light source to be tested to the rear connector (see
measurement "Connection to the power meter, VFL and Talkset" page 26).

2 Inthe SETUP menu, choose the units dBm, dB or Watts.
3 Press the START/STOP key to start the measurement.

The result will appear in the results page and can be memorized in
the table (see "Table of results" page 28).

4 Press the START/STOP key to stop the measurement.

Optical link loss Setting the zero value of the power meter

measurements where accuracy is required, as the noise from the ger-
manium photodiode fluctuates over time and with variations in tem-
perature.

j It is important to set the zero of the power meter before making any

1 Fix the plug over the optical input of the power meter so that no light
can reach the photodiode of the power meter. If the zero adjustment
is made without this plug, an error message may be displayed, as
the photodiode will detect too much light.
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VFL Function

2 Inthe Results page, press the Powermeter Config. > Zero soft key
and validate.

Carrying out the reference measurement

1 Fix the adapter corresponding to the jumper to the optical connector
of the power meter.

2 Connect the jumper between the input of the power meter and the
output of the source.

3 Configure the same wavelength on the source and the power meter.

The power measured is displayed in the results page of the power
meter.

4 Press the Pow Reference > Standard Ref soft keys to save the
result displayed as reference value.

Measurements on the fiber under test

After defining the reference value, proceed as follows to make the
measurement:

1 Fix the jumpers and connectors needed to connect the fiber to be
tested between the source output and the power meter input.
2 In the set-up menu, select dB units.

3 The power displayed in the Power Meter window corresponds to the
optical loss of the link tested. It can be displayed in the table (see
"Table of results" page 28).

VFL Function

VFL connector

Visual Fault
Locator
function (VFL)

The type of optical connector used for the VFL source is UPP (Universal
Push Pull), which is compatible with all diameter 2.5 mm connectors (FC,
SC, ST, DIN, E2000, etc.)

See Figure 12 on page 26 to visualize the VFL connector.

This function is used to emit a red light signal of frequency 1 Hz or in
continuous mode into a fiber to detect any defects in the dead zone of the
reflectometer, or to identify it.

This function is suitable for short fibers (length < 5 km) or the first few
metres of a long fiber.
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Storing and reloading results

NOTE
Identification is facilitated by the blinking of light in the fiber.

To emit a light signal into a fiber:

1 Connect the fiber to the VFL port on the connectors panel.

2 Press the HOME key and activate the VFL @

The icons &ﬁ,{i display on the upper banner of the screen.

The signal mode of the VFL can be modified in the System Settings
page, in Utility > VFL Mode parameter.

Storing and reloading results

File Setup Click on the button FILE to access the File setup. See the chapter «File

Storing results

Loading results

32

management» in the user manual «2100 modules series» for a complete
description of all parameters, options and description of the explorer.

In order to save the results of a measurement, click on FILE and select
Store trace. Two files are being saved :

— The first file is used with the 2000 Platform and allows to retrieve all
measurement results. It is saved with the extension «.Lts».

— The second file is a ASCII file using tabulations to separate values.
It is saved with the extension «.txt» and can be opened by the 2000
Platform. It has been designed to be used with a spreadsheet
program on a PC where it allows to retrieve all measurement results
and format them in a nice customized table.

In order to load the results of a measurement, select a file with the
extension «.Lts» in the file explorer (see the chapter «File management»
in the user manual for «2100 modules series»), click on Load then
Confirm Load.

The LTS tab is displayed with the loaded results in the table
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Talkset Function

Talkset Function

The Talkset option enables two operators at opposite ends of an optical

link to communicate along the fiber. Each end of the optical link must be

provided with a 2000 Platform equipped with the Talkset option.
mm NOTE

It is possible to use the talkset of the 2000 Platform and to carry out
measurements at the same time, on a different fiber.

Talkset The talkset configuration is set in the System Settings screen, in the
configuration Chan;:; box (see "Defining the Audio parameters of the 2000 Platform"
page

Connections At each end of the fiber:

1 Connect the fiber to the Talkset port of the 2000 Platform, either
directly or through jumpers.

JDSU recommends you to use the following connections:
A - PC Fiber Connection (APC is not recommended)

- SC or FC connection (UPP is supplied but not recommended).

Fig. 15 Installation for Talkset use

2 A headset (with earphones and a microphone) supplied with the
option may also be plugged into the 2000 Audio jack.

Establishing On the caller 2000 Platform, press the HOME button, then validate the
communication Talkset option:
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Talkset Function

— Ifthe remote instrument is ready to receive (on standby), the Talkset
icon turns orange, beeps are emitted, and the icon appears at
the top of the screen: telephone communication can now take place.

— If the remote instrument is not ready to receive, the Talkset icon
does not change color and a message is emitted.

mmmmm NOTE

The talkset icon is displayed on the top banner as long as communi-
cation remains established, letting the user know that the connection
is working.

When communication is established, the headset is automatically
enabled if plugged in. However, the loud speaker must be correctly
configured in the setup menu to work accordingly

Adjusting The sound is transmitted to the earphones of the headset and, if this
volume leve| functionhas been activated, to the speaker in the 2000 Platform base. To
activate the base loudspeaker and adjust the volume:

1 Press the HOME key.
2 Validate Settings icon to reach the System Settings page.

3 Under the Audio box, select Headset Volume and adjust the
volume.

Disconnection Wnhen communication is over, deactivate the Talkset function on the
2000 Platform. This deactivation can be done by either 2000 Platform.

Then, the fiber used for Talkset, can be disconnected from each Platform
safely.
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Scope

The scope function is a hot-plug feature enabled directly when inserting
a JDSU scope supplied as an accessory (see "References of accesso-
ries" page 76).

The topics discussed in this chapter are as follows:

— "Scope feature" page 36

— "Installation of tips" page 36

— "Configuring the P5000 Scope" page 37

— "Starting up with the scope" page 39

— "Launching a test of the connector and fiber end-face" page 40
— "File menu" page 43
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Scope feature

Scope feature

Overview This feature enables you to verify that your optical connectors are in
perfect shape and very clean condition.

The P5000 Digital Probe Microscope is a portable handheld microscope
used to view and inspect both the bulkhead (female) and patch cord
(male) sides of fiber connectors as well as other optical devices, such as
transceivers.

The P5000 requires an FBPT inspection tip and is connected to the 2000
Platform with a USB 2.0 connector.

Quickcapture'™ button
Instantly captures the image

Focus Control

Inspection tip

et
=y

Barrel assembly USB 2.0 6 FT COIL Cable
connector Latch lock
Squeeze both ends to release

Fig. 16 P5000 Probe components

Installation of tips

36

The Pass/Fail analysis function on the 2000 Platform can only be used
with certain inspection tips mounted on the P5000.

Pass / Fail results

Standard patch
cord tips
Barrel assembly

Standard
bulkhead tips

Fig. 17 Use of tips
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Configuring the P5000 Scope

Configuring the P5000 Scope

Scope
connection

Configuring the
Scope

1 Plug in your JDSU scope into a USB port from the 2000 Platform.
2 Push the button HOME =

3 Validate the Scope function E

4 Connect probe with the fiber being inspected.

You may select this option while other options are already selected (e.g.
OTDR).

1 Press Setup key to configure the test.
The following screen displays:

1

Pradila ADC_SH-UPC IEC_58-ARC ) D 884 )

FRDaG Tyee (vep) FRF-FRDOO

i

Eampasy JEL sk

Laga JOSU loga, color-blsck pay

e lahn Das

e

Filbwr Ny

Pbar mumbar '

Lnit

Fig. 18 P5000 Scope Setup

Test On the line Profile, select the Profile which will be used for the test of

fiber connector:

— |EC SM-UPC: Pass/Fail criteria for single-mode UPC connectors
from IEC 61300-3-35 standard.

— |EC SM-APC: Pass/Fail criteria for single-mode APC connectors
from IEC 61300-3-35 standard.

Profiles contain the analysis parameters by which PASS/FAIL criteria are
determined.

Once the line is selected, you can also add a new profile, clicking on the
Add Button (see "Adding a new profile" page 38).
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Configuring the P5000 Scope

38

Report

Fiber

Adding a new
profile

The parameters in Report box allow to configure the Report page setup.

On the line Company, enter the name of your company using the edition
keypad.

On the line Logo, you can select an image on the 2000 Explorer once
clicking on the right arrow key, which will be displayed on the upper left
part of the report. Press the SETUP key to return back to the Setup page.

On the line Operator, you can enter the name of the operator, which will
be displayed on the header of the report.

See Figure 22 on page 44 for a description of the pdf report.

The Fiber box allows to configure the fiber plugged to the scope.

On the line Fiber Name, use the edition keypad, which will display by
clicking on the right arrow key, to enter a specific name for the fiber.

On the line Fiber Number, use the numeric keypad, which will display by
clicking on the right arrow key, to enter the fiber number.

Press Exit to return to the Results screen of the scope.

Once the Setup screen of the scope is displayed, you can add a specific
profile which will be used for the test.

The profile must be created via FiberChek2™, and stored on one

storage media of the MTS/T-BERD 2000 (disk, or USB memory stick).
On the Setup screen, select Profile and press Add key.

2 On the explorer, select the file which will be used as profile (icon

; extension: .PRO)

3 Press Load.
Once loaded, the display goes back automatically to Setup screen.
4 Select the profile just loaded.

Removing a profile
1 In the Profile list, select the profile to be deleted.
2 Press Remove key., then Exit.
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Starting up with the scope

Luminosity and
Contrast
settings

Once the FiberScope icon is validated:

1 Press RESULTS hard key

Profile | IEC SH-UPC B

-l Scn
* M

¥ Cgmany
T

 Hig g
— Timw mag

Llim

Fig. 19 Example of the result using the P5000 scope

Luminosity and contrast may be set manually by using the
key Bright/Cont.. Once you select which parameter you
wish to modify, use the arrow keys A and W to tune the
luminosity or contrast to the desired value. Note that the
set values are displayed on the key.

" Bright. 10
# Cont. B3

o

Auts

You may also choose to use the function Auto Contrast in Contrast

order to get settings calculated automatically by the instru-
ment.

NOTE

Saturated parts of the picture appear in yellow. Modify the luminosity
and contrast settings or use Auto contrast to modify the actual set-
ting and remove saturation.

Auto Contrast must be used with a pristine (perfectly clean,
undamaged) fiber connector. Changing the brightness or
contrast settings can significantly change the fiber inspection
test resulit.
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Launching a test of the connector and fiber end-face

Freeze mode oOnce the image is acceptable (sharpness, luminosity and contrast are
tuned correctly), you may freeze the picture. This feature allows to store
in memory the resulting picture.

Freezing a scope result does not store the picture in a file (see "File
& menu" page 43). The result will be lost if the instrument is shut off, or if
—

more than 3 pictures are frozen (see "Mosaic Mode" page 42).

NOTE

The button set on the lead, or the QuickCapture™ on the P5000
allows to freeze the picture or to take a snapshot.

Adding a comment

A key Comment allows you to enter/modify a comment to your picture if
necessary. This comment appears at the bottom left of the picture.

The right bottom of the frozen picture also contains the date of the acqui-
sition (where the picture was frozen).

mmm NOTE

Both the comment and the date will be saved with the picture.

Camera mode Setthe key Cameral/Freeze on Camera, to get a live picture of the scope
result.

j Use the focus control to adjust the focus of the image

Launching a test of the connector and fiber end-face

Launching a Once the Brightness and Contrast parameters are correctly defined for
test of the the currentimage (see "Luminosity and Contrast settings" page 39), a
test of fiber connector can be launched.
connector and

fiber end-face The High mag./Low mag. key allows to display the picture with a high
or low magnitude.

To launch the test:

1 Press Test key to launch the test of plugged fiber connector.
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Launching a test of the connector and fiber end-face

The test is completed:

— once the Led Testing is no more lit in red

— oncetheicon T is no more displayed on the upper banner
— once a screen as the following one displays:

NOTE

To configure the Pass/Fail critera, refer to “Configuring the Scope” on
page 37.

Profile selected—#refile  [EC_SM.UPE o T o9 22008 |
P =0 Eail | temmemt | Summary of
’ b o & Test results

i L fena B {

Saww
Tesl

ol s |
| " M

 Camars
= frpare

L= Testresultin

| IMroscope |

L mag’
High mag.

Fig. 20 Test results

A summary of test results is displayed on the right, upper part of the
screen.

— Zone A: represents the Core zone: it is the area
surrounding the core

— Zone B: represents the Cladding zone. It
surrounds the majority of the fiber cladding. ?

— Zone C: represents the Ferrule zone: it identifies
a portion of the ferrule near and around the fiber

NOTE

To return to a Live Camera image, press the Cameral/Freeze key; or
press the Full Screen/Mosaic key view both the live image and a test
result simultaneously.

In Mosaic mode (see "Mosaic Mode" page 42), the result of the test

only displays Pass or Fail information; the status of each zone is dis-
played only in full screen mode.
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42

Mosaic Mode 1t is possible to display only one picture in full screen (640 * 390 pixels)

or up to four pictures (320*180 pixels each, including the live camera
picture) in mosaic mode. Use the key Full scr./Mosaic to switch from
one mode to another.

Position 1 : Position 2:
LIVE CAMERA Snapshot saved on disk : connector cleaned

Selected picture
B A% 10:00 110L2010

Prafile \JEC_SM-UPC

Camimsht

Position 3 :
Connector before
being cleaned

™ Fall Son
% Mo LasE

 High mag.
= Low mag.

Position 4 : Regul& JPEG image

Fig. 21 Mosaic mode

— You may select one of the pictures by clicking on it.
The selected picture is framed in green.

The toolbar on the right varies according to which picture is selected
(camera, or static picture):

Picture selected: Camera

All the Contrast and Luminosity settings are available just like in full
screen.

Snapshot The live picture from the camera is frozen but does not
replace the live picture at position 1. The new snapshot
is placed at the second position, and all existing pictures
are pushed to the next position.

tion is unloaded from memory. Frozen pictures and snapshots are

If all positions were taken, the picture that was once at the fourth posi-
A lost, unless they were saved on the internal memory.
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Chapter 6 Scope
File menu

It is possible to retrieve and load a picture stored in the Scope directory
and display it in the Scope page.

1 Press the FILE button.

2 Select Load.

3 Select the JPEG file to be loaded via the Explorer
4 Click on Load >Confirm Load

Recognized pictures are images resulting from the Scope option and
saved on disk via the 2000 Platform.

Some pictures resulting from the Scope option may appear
nevertheless unrecognized, if they have been stored with a
different Scope application, or if the JPG file has been opened
and modified under another JPG editor.

Even though the JPG editor of the Scope function has been designed to
display Scope pictures in black & white, it is also possible to open any
JPG valid file and display in color the corresponding picture. That picture
is enlarged or shrunk to the size of the display (full screen or mosaic,
see."Mosaic Mode" page 42).

File menu

Saving the test
result in a jpg
file

Generating a
report

Once the test has been performed, and the result is displayed on the
2000 Platform screen:
1 Press FILE key

2 Click on Save key to save a jpg file of the test result on the disk of
the 2000 Platform.

3 On the edition keypad, enter the name of the jpg file
4 Press Enter to validate.
The file is automatically saved on the disk, in the directory Scope

(icon (@ ])-

1 Check the correct test result is selected (framed in green in mosaic
mode)..

Press the FILE button, then the Report key

3 On the edition keypad, enter the name of the pdf file and press
ENTER.
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File menu

44

The report generation is completed once the icon i is no more
displayed on the upper banner.
mm NOTE
The pdf report will be saved on the disk, in the directory Scope.
Display of the report
Once the report has been generated:
1 Return to the HOME page, and select the File Explorer
2 Select the pdf file of the report in the directory Scope.
3 Press Load > Confirm Load.
Logo, company & operator
name selected in the \> JDSU e
Setup page (see “Report”
on page 38) 105 Uniphase
Operator Chilta
Prabae FEP-PROO0 perial S2092000
T e 070178 1743 PASS
Fibar I SOl
Fafie ]
Inspection Summary
i Damaimr Dadmctn Srrubches
inner Getei Rasiill Counl Bl e
Tk & a n ML a PAS a
Tors B e (1] PASS o &
Tobts C 1 P L] 1 L L L ]

el

Fig. 22 PDF report
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File management

The files management with the 2000 Platform can be performed, wether
a module is set onto the 2000 Platform or not.

The topics discussed in this chapter are as follows:

“File Explorer Overview” on page 46

“Directories and Files selections” on page 46

“Directories & Files editing functions” on page 47

“Working with directories and files from the explorer” on page 48
“Creating a screenshot” on page 55

“Creating a report” on page 56

“Merging pdf or txt files” on page 58

“Storage media” on page 59
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File Explorer Overview

File Explorer Overview

To reach the File Explorer page

— On the Home page, select the File Explorer icon.
The File Explorer page appears.

g File Explorer '\ Ty H.0% SN0l
T 10 r e ==
= 11am PRt
=
= 1t a3iam am 3
Creéate
[l merpa, 3ace 171 e Tale
55l mernoa 10 423 S JAOLAL LA
] iiserpea v a3 o PURLAL L3
=5 mewrnar 5300 AT ] & JAOLAL LAY

S il REY BEF ABAAYL AR
Eae

*

Epect USB

Fig. 23 File Explorer page

Directories and Files selections

Directory
selection

46

To select a directory from the explorer page:

1 Press on the directory that must be selected on the left of the
screen.

The list of files the directory countains displays on the right side of

the screen
The selected directory is underlined in blue

2 Click on the arrow at the left of the directory name, or press valida-

tion hard key o , to display the sub-directories if any.

Acces.s to e E
sub-directory

B sub-directory «—— Sub-directory

Fig. 24 Directory selection
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Files selection To select one or several files from the explorer page:

1 Press on files that must be selected.
or
To select a list of files using the keys of the Platform:
a Select and validate the first file of the list (underlined in red)
b Set the cursor on the last file of the list (underlined in blue)

¢ Maintain the right direction key } pushed until all the files are
selected.

or
Click on Select all menu key to select all files into the directory.

mmmm NOTE

The last selected file is underlined in red and the previous one(s)
selected is/are undelrined in blue.

Selected files

Mlabgesr | % & »a
Selected L Sy
directory e L SE— W |
‘m e B e | e .
Fig. 25 Example of files selection

Directories & Files editing functions

CopyICut & To copy (cut) one or several files, or one directory, and paste them in
Paste files/ another place:

directories 1 Select the directory / the file(s) (see “Directories and Files selec-
tions” on page 46).

2 Press Edit menu key
3 Press Copy to keep the directory / file(s) to their initial location.
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or
Press Cut to delete the directory / file(s) from their initial location

4 On the left of the screen, select the directory; or select the new
storage media.

5 Click on Paste menu key.

-

Renaming a Select the directory / file to be renamed (see “Directories and Files

directory | file selections” on page 46).
2 Press Edit > Rename Directory or Rename File.

The Edition keypad displays.

Fig. 26 Edition keypad for renaming file

3 Press Clear if you wish to delete the entire name
Enter a new name for the directory / file.
5 Click on Enter to validate the new name.

-

Deleting a Select the directory or file(s) to be deleted (see “Directories and
directory | file Files selections” on page 46).
2 Press Edit > Delete.

A confirmation dialog box displays.
3 Press Yes to delete the selected directory or file(s).
Press No to cancel the deletion.

Working with directories and files from the explorer

Creating a To create a new directory from the explorer page:
directory

Check the cursor is set on the left of the screen
2 Select the storage media into which the directory must be created
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3 If you want to create a sub-directory, select the directory into which it
must be created.

4 Press the right menu key Create Directory.
The edition keypad displays

5 Enter a name for this directory
Press Enter key to validate the new directory

Opening files oOnce afile is selected, press Load, then Confirm Load menu keys.

with trace files (example: all OTDR trace files if a reference trace
has been defined). Other type of files (PDF, TXT ...) must be open
one by one.

j Opening several files at the same time can be done exclusively

If different types of files have been selected in the Explorer, only
the last one selected will open.

File Types For files recognized by the 2000 Platform, the types are symbolized by
icons. E.g.

Icon Type of FO file

| OTDR file (.SOR extension)

Multi OTDR file (MSOR extension)

OSA file (.OSA extension)

Power Meter file (.LTS extension)
Icon Type of file

(@] HTML file (HTML extension)

PDF File (.PDF extension)

Text file (.TXT extension)

License file (.LIC extension)

o CSV file (.CSV extension)
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50
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Sorting files

Transferring
filestoa PC

Establishing
connection 2000
Platform <-> PC

Icon Type of file

JPEG / JPG file (.JPEG extension)

PNG file (.PNG extension)
XML file (.XML extension)

With the 2000 Platform, you can open and load any kind of FO
files (OTDR, OSA, PON, LTS) even if the corresponding module
is not set into the Platform.

Wether files are selected or not, the key Sort allows to access to a sub-
menu allowing to sort te file accorfing to pre-defined parameters:

— Sort by name: the files display in an ascending order (from A to Z).
If you click once again on the key, the files display in a descending
order (from Z to A).

— Sort by size: by cliking once on this key, the files display from the
smallest to the heaviest one. Clicking a second time allows to sort
the files in opposite order.

— Sort by type: clicking once on this key; the 2000 Platform displays
files in an ascending order (the file type A to file type W). By clicking
again, the 2000 Platform displays the files in opposite order.

— Sort by date: clicking once on this key; the 2000 Platform displays
files from the more recent to the less one. By clicking again on key,
the Platform displays files from the older to the more recent one.

NOTE
You can also sort files clicking on the column titles in the files list

If some Results traces or other kinds of file need to be transferred to the
PC, this can be easily done using the USB cable delivered on standard
with the 2000 Platform.

1 Connect the 2000 Platform to a PC, plugging the USB cable on the
mini USB port of the Platform toward a USB port on the PC.
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- _— . 1
e | & ‘E=== s |
.'"-. ; T

USB port on the PC

A . \
Mini USB Port on

the 2000 Platform |{[==r1| a

i m—] :

il 4]

UsB Cable

Fig. 27 Direct connection 2000 Platform <-> PC

2 Once connection is established, confirm that you wish to activate
the USB link in the pop-up window on the 2000 Platform.

id Export over US8 link activated LT 1178 0a/TWI011
% USH cabE M usE |
L) - —n
Am
= Do ish t t fike the LISE Confirm
w You wish o axpo % Ower
P — 9 link?
= LA rurming applications will be stopped) |
[ Canced
y
e
e
o ]
e

Fig. 28 Confirmation of files export via USB cable

A message displays on the bottom right side of the PC informing a
new hardware is detected.

3 Click on the message and select «Open folder to view files» in the
dialog box JDSUDISK (F:) («F:» is an example, it can be different
according to your PC and to the USB port used).
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Fig. 29 Open 2000 disk content

The 2000 platform disk content opens onto the PC.

Transferring files 1 Select the file(s) from the 2000 Platform to be transferred onto the
onto the PC PC

Fig. 30 Files selection from the 2000 Platform

2 Press Ctrl + C, or right click and select Copy.
3 On the PC, select the directory in which file(s) will be transferred.
4 Press Ctrl + V, or right click and select Paste.

Cancellng the Once all desired files have been transfer onto the PC, connection
connection between 2000 Platform and PC can be removed:

1 On the PC, use the appropriate method to safely remove the USB
cable from the USB port.

The screen displays the results trace of the active function, or
returns to the Home page if no function is active..
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Working with directories and files from the explorer

Remove the mini USB plug from the 2000 Platform USB port.

The Bluetooth option allows file transfers between the 2000 Platform and
another device.

-

On the Home page, press System Settings key

Under /O interfaces, select Bluetooth > Enable

The icon % is displayed on the upper banner of the screen
Push the Bluetooth Pairing menu key |5

The Paired Bluetooth screen appears

Do one of the following:

Press the Become Pairable soft key to wait for another device to
initiate the connection to the 2000.

or

If the desired device is not displayed on the screen, or if no devices
are detected, press the Search Devices soft key.

The 2000 Platform is searching for the devices which could be used
via Bluetooth with the equipment.

REMINDER
You may need to activate bluetooth on the other device to allow
pairing.

A baragraph is displayed during research

Once the research is completed, a list of the available devices is
displayed, with the level of detection of the 2000 Platform.

— Gystem Settngu i ] W il

Blaino deved found

55H: FABD glepd )
- Level of detection

Fig. 31 List of devices found
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a Select the device to be paired with the Platform underlined blue
b Push the Pair key to connect the device to the Platform

5 If prompted, enter a pairing code. The code must be identical on the
2000 Platform and the device.

6 Once the bluetooth device and the Platform are paired, a screen is
displayed with the description of the device

Sagrrh
Paired Bliessaih devaces Devices

Beoeme
SGH-FABY wheph Fakabie

REmee
Faring

Fig. 32 Device paired with Platform

The icon has a blue background when paired with a device EB

You can now go to the file explorer and transfer files from the 2000 Plat-
form toward the bluetooth device and vice versa.

Transfering files Once the connection has been established with a bluetooth device:

via Bluetooth Go in the File Explorer.

Select the file(s) to be transferred from the Platform toward the PC.

Press Export menu key. Send by
Blustooth

A ODN =

Push Export > Send by Bluetooth menu keys
A confirmation message displays once the transfer is completed.

S By
Bisstzath

Fig. 33 Confirmation of files sending
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Creating a screenshot

You can also transfer file(s) from the bluetooth device toward the Plat-
form.

In this case, the files received will be stored in a storage media created
automatically on the Platform: bluetooth-inbox.

WARNING

The files stored in bluetooth-inbox will be lost once the 2000
Platform is switched off. Move the files to keep toward another
storage media (disk, usb key...).

1 To remove the pairing between the two equipments, in the System
Settings page, push the Bluetooth Pairing key

2 In the screen displayed, push the Remove pairing key

The icon on the upper banner of the screen becomes § showing the
Platform is no more connected to a bluetooth device, but the Bluetooth
option is still active.

To deactivate the bluetooth onto the Platform, go in the System Settings
page, and under I/O Interfaces, select Disable on the Bluetooth line.

Creating a screenshot

Configuring the
parameters of
screenshots

Taking a
screenshot

You can create captures of what is displayed on the screen, directly from
the 2000 Platform.

To configure the screenshot and choose the format of the generated file:

-

Press HOME hard key
Select the Settings icon to reach the System Settings page.
3 Inthe Report box, on the line Mode, select Screenshot

N

Choosing this option, you can save the displayed screen in JPG,
PNG or PDF format, exactly as it is displayed on the screen.

Therefore, if you make a zoom on the trace for example, the file will
only show the zoom section.

4 On the line File format, select if the printed file will be a JPG, PNG
or PDF file.

Once the screenshot parameters are configured:

1 Reach the display which will be saved as a screenshot in a file.
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2 If necessary, make modifications on this display (example: zoom on
trace...)

3 Press simultaneously the left and right arrow keys 4 } for
about 5 seconds

or

Click on the upper banner of the screen and, in the virtual control
buttons bar, press Export key

Theicon = displays until the end of process.
4 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

Name of the The screenshotis saved in afile, which is automatically named as follow:

screenstfwts —  Print_date (year/month/day)_time (hour/minut/second).jpg/png/pdf
1es

“F Wob Browser - Pt 2011 05 3 B UE14 FEAmT011

1 e Wy Rt

= e km 15500 m 3 0ns B 1 -

13%%0nm XM= 11 1 Boskenwi
m—atiam A5 a0WABM 10.133dB @

| Ao

[ . Ty 1 i 1 Mouine

Wiy Evti 4 Livk Qi 40,55 «B &

vert Distance Km Lodial Bsfiect dB Slope dliem Secten Km T Lods a8 Ixk
SRS M 0485908 -
¥ ol El
Fig. 34 Example of screenshot, open in the Web Browser of

the 2000 Platform

The file is saved in the directory Print, on the storage media disk.

Creating a report

Once the results page of a function is opened (example: OTDR trace,
Power Meter results...), it can be exported in a report, using the 2000
Platform.

Configuring the To configure the report and choose the format of the report file:
report 1 Press HOME hard key
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Select Settings icon to reach the System Settings page.
In the Report box, on the line Mode, select Report.

Choosing this option, you can save the open file in a JPG, PNG or
PDF file report, exactly as if the file was printed on paper.

Therefore, if the file is too large for one A4 page, several JPG, PNG
or PDF files will be created.

On the line File format, select if the report file will be a JPG, PNG or
PDF file.

To display a Logo on the upper right of the report pages, click on
Logo line and select the Logo to be displayed on the upper right of
the page:

a Press } to open the edition keypad

b Enter the path of the logo file (example: disk/jdsu logo.jpg)

¢ Press Enter to validate.

5. Aeports wl
Mode Report
File Format FDF

Logo disk/JDSU_Logo.jpg

Fig. 35 Example of Report configuration

Creating the 1
report 2

3

Open the file to be saved in a report in JPG, PNG or PDF format

If necessary, make the modifications on the file/trace (see user
manual of the 2100 OTDR Modules for OTDR trace files).

Set the trace view as wished.
For OTDR traces

— if the function is set to the Trace mode (Trace is selected on the
menu key Trace/Table/Summary), the JPG/PNG/PDF file will
countain the header and the trace (in one page).

— If the function is set to Table mode (Table is selected on the
menu key Trace/Table/Summary), the JPG/PNG/PDF file will
countain the header, the trace and the entire results table
(several pages may be required)

— If the function is set to Summary mode (Summary is selected
on the menu key Trace/Table/Summary), the JPG/PNG/PDF
file will countain the header and the summary page, with either
the Bend table or the Alarm Table according to the selected item
with the menu key.

This view is only available with OTDR traces.
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4 Click on the upper banner of the screen and, in the virtual control
buttons bar, press Export key

Theicon = displays until the end of process.
5 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

The files are saved in the directory Print, on the disk media
storage.

Name of the Ifatrace has been savedin a report file, the name of the JPG/PNG/PDF
report file is as follow:

— name of the stored trace_date (year/month/day)_time (hour/minute/
second).jpg/png/pdf

mmm NOTE

If several traces are displayed in overlay, a different report file is gen-
erated for each trace open.

M PO feader - Fiberd0] Y10E 20 N, BC

Fig. 36 Example of report (in pdf)

Merging pdf or txt files

In the Explorer page, two pdf files or more, generated via the results
traces can be merged in one pdf file.

— The pdf files that can be merged are those generated via the Fast
Report key on trace results page (see “Creating a report” on
page 56)
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— The txt files that can be merged are those saved with the results
trace (see OTDR Modules User Manual: E2100M02)..

1 In the Explorer, select the two or more pdf/ixt files generated
2 Press Export menu key

Press Merge key

taen W miinllamn

SR NLL LE W

Merge

VRNl 22

¥
il Cabie besy W8 ORI r EAOLL D
]

Fig. 37 Files selection and Merge key

The icon .'}: is displayed during merging process.
After a few seconds, the files are merged in one pdf/ixt file, which name
by default is: merged_year_month_date__hour_min_sec.pdf

The file is automatically saved in the same directory as the one where
files have been selected.

It gathers all results from pdf/txt files selected (and traces for pdf file), in
one single pdf file of several pages (1 results screen per page, if the
results table does not exceed one page).

NOTE

Once merged file is saved, it can be renamed in the Explorer (see
“Renaming a directory / file” on page 48).

Storage media

For saving or recalling data, the 2000 Platform offers a wide choice of
media, both built-in and external.

Free space on selected media is clearly displayed at the bottom of the
left panel.

User Manual 790000002/00 59



Chapter 7 File management
Storage media

Storage media The 2000 Platform is delivered with an internal memory , which maximum
built into the capacity is of 1GB (with a minimum of about 128 Mb are available for

2000 Platform data storage).

External USB The 2000 Platform is equipped with 2 USB ports as standard. One of
storage media these can be used to connect an external storage medium, in particular
a USB memory stick.

mm NOTE

Although two USB ports are present, it is not possible to use simulta-
neously more than one external USB storage medium.

USB memory stick 1 Insert the USB memory stick in one of the 2000 Platform's USB port.
connection A sound is emitted to confirm the successful insertion and recogni-
tion of a USB memory stick.

Then, the icon \ is displayed in the upper banner to inform the
user the USB stick is ready to be used.

the move on the screen does not mean that writing of data into
the memory is complete. Some data may still be in a writing
process if the storage unit is removed prematurely.

j When a file is moved in the explorer of the Platform, the end of

USB memory stick 1 Before disconnecting the USB memory stick, always select a
disconnection storage device different from usbflash (select disk for example) in
the explorer.

2 Make sure you no longer have any running applications using the
usbflash storage media.

3 The user must push the EJECT USB key, available in File Explorer.

The icon becomes & to indicate it can be removed safely. In this
state, the USB stick cannot be used anymore

The USB memory stick can then be disconnected from the Platform USB
port.
mmmm NOTE

The USB memory stick can also be removed using the Expert Tools
> Media Utilities menu, accessible via the System Settings page.
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See Chapter 11 “Maintenance and Troubleshooting” if any problem
occurs with the USB memory stick

Abbreviations The abbreviations used in the explorer for the different storage media
for storage 2

media
Abbreviation Storage medium
disk Internal flash memory
usbflash USB memory stick

bluetooth-inbox | Bluetooth storage media (option)?

a. The files stored in bluetooth-inbox are lost when the Platform is
switched off.
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Transferring the 2000
Platform Interface

The 2000 Platform can be used in combination with a PC in order to
transfer the Platform Interface onto a PC, or to access the internal
memory or USB memory stick contents on the PC.

Topics described in this chapter are as follows:

— “Establishing connection” on page 64

— “Transferring the Interface” on page 66

— “Virtual control buttons bar” on page 67

— “Equivalence between the keyboard and 2000 Platform” on page 67
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Establishing connection

The connection between 2000 Platform and the PC can be done directly,
or via a local network.

The transfer of the interface can be done using a VNC window on PC.

WAN network, it is strongly recommended to use a dedicated
VNC client. The VNC clients recommended are Tight VNC (V 1.2.9
or later) and Real VNC (V 4.1.1 or later).

j For an intensive use of the deport screen or when it is used via a

Connecting the 1 Connect the 2000 Platform to the PC via an Ethernet cable, using
2000 Platform the RJ45 connectors set on both equipments.

and the PC

e

]

i ;

=

=

-

Fig. 38 Connection 2000 Platform and PC

2 Check the network connection on the PC is set in Dynamic mode.

Configuring the 1 Inthe Home page of the 2000 Platform, validate the Settings icon.

2000 Platform 2 inthe System Settings page, in the I/O Interfaces box, configure
the following parameters:

Ethernet > Mode

Parameters of the local Ethernet network to which the 2000 Platform is
connected:

Config 1to 4 static mode enabling input of the configuration of

4 sites. If this parameter is selected, the folowing
parameters must be entered:

— Site Name the user can enter the name of the site in the Edit
menu.
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— IP Address
— IP Mask
— IP Gateway

- DNS'
— Domain name

Dynamic

NOTE

Chapter 8 Transferring the 2000 Platform Interface
Establishing connection

IP address of the 2000 Platform

address of the mask of the sub-network

IP address of the machine enabling access outside
the sub-network.

IP address of the machine providing the IP
address on the basis of the name

name of the local network to which the 2000 Plat-
form is connected.

in this mode, which requires a DHCP server, the
2000 Platform requests an IP address from this
server which will be allocated dynamically if
dynamic host configuration is activated on the
local network.

After selecting this mode or after power-on, the
2000 Platform tries to establish a connection to
obtain an address from a DHCP server. If for any
reason, this process fails, the 2000 Platform
reverses to static IP address mode with User1 IP
address.

=]
Once the 2000 Platform is connected to the network, the icon &
indicates the connection is working.

Proxy > Use proxy

1 Select No if no proxy is used.

2 If Manual has been selected, enter the Proxy Address.

3 If Auto has been selected, enter the Pac Address.

Surtoolioam Dyramic. Config 1 [ Contig 7| Contg 3
Note the 2000 Platform ‘ Carf 4 Dynamic
IP Address ™
Fig. 39 Example of configuration for I/O Interfaces box

4 Note the IP Address displayed in the System Settings page.

5 Wait about 10 seconds the connection is established.

The 2000 Platform Interface can now be transferred onto the PC, or the
internal memory or USB key ocntents can be transferred on PC..

1.Domain Name Server
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Transferring the Interface

Once the connection is established between the 2000 Platform and the
PC, proceed as follow:

1 Open Internet Explorer on the PC.

2 Considering 10.33.18.93 is the IP Address of the 2000 Platform
(as shown Figure 39 on page 65), enter the following address in the
Internet Explorer window:

http://10.33.18.93:5800
3 Press Enter to validate.

A VNC window opens, demanding a
password

4 Press OK without typing any password.

The screen of the 2000 Platform appears offset on your PC.
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Click to install TightVNC software
on your PC (not mandatory) —».

Fig. 40 VNC window

You can use keyboard mouse of the PC to control the 2000 Platform (see
“Equivalence between the keyboard and 2000 Platform” on page 67).

mmm NOTE

Once Remote screen is accessbile via VNC, the icon L= displays
on the upper banner of the screen until the connection is cut or the
2000 Platform is switched off.
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Virtual control buttons bar

It is possible to emulate hard keys with Virtual Control buttons. This
virtual control buttons bar is especially useful when the 2000 Platform
screen is exported on a remote PC.

To display those buttons, click once on the top of the screen in the status
bar, at the same height than the date and time.

[ “Exporc 1 Home I Fie | Sewp | Resuts | StariStop || Enter

Fig. 41 Virtual control buttons bar

The virtual control buttons bar is displayed during a few seconds. You
may click on any of these buttons to obtain exactly the same results than
using the hard keys on the front panel of the 2000 Platform.

Equivalence between the keyboard and 2000 Platform

The PC keyboard can replaced all the buttons and keys of the 2000 Plat-
form except the ON/OFF button:

— The menu keys to the right of the screen are replaced by the func-
tion keys F1 to F6.

— The buttons below the screen are equivalent to Ctrl + a letter (see
table below).

— The direction keys have the same function on the external keyboard
and on the 2000 Platform.

Function on the 2000 Platform External keyboard
HOME Ctrl + H
SYSTEM SETTINGS F12
SET-UP Ctrl + U
FILE Ctrl + F
RESULTS Ctrl +R
START/STOP Ctrl +S
EXPORT Ctrl + P
dA)) vV --®
Menu keys 1 to 6 (from top to bottom) F1— F6
ABOUT F11
Save and quit (Exit) Entrée/Enter
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Equivalence between the keyboard and 2000 Platform

Function on the 2000 Platform External keyboard

Quit without saving (Abort) Escape/Echap.

a. The Export function is available directly on the 2000 Platform pushing
simultaneously the left and right arrow keys.

mmmm NOTE

Those equivalences are also valid with a keyboard directly connected
to the 2000 Platform via one USB port.
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Technical specifications

This chapter contains the technical specifications of the 2000 Platform
mainframe.

The topics discussed in this chapter are as follows:

— “Display specifications” on page 70

—  “Memory” on page 70

—  “Input/Output” on page 70

— “Power supply” on page 70

— “Dimensions - Weight” on page 71

— “Environment” on page 72

— “Characteristics of the options” on page 73
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Display specifications

Display specifications

Screen - Backlight color touchscreen
— Size: 5inches
— Resolution: 800 x 480 pixels

Memory

— Standard memory: internal memory, with a capacity of 1GB (with a
minimum of about 125 Mb are available for data storage).

Input/Output
— two USB 2.0 host ports.
— one Mini USB 2.0 device
— one RJ 45 connector for Ethernet interface 10/100/1G
—  built-in loudspeaker
— headset jack

Power supply

Battery The instrument can be supplied with one Li-Polymer battery.

Endurance of the 2000 Platform with battery

Measurement conditions:

- at+25°C,
— at full battery capacity (4.5 Ah),
— 2000 Platform equipped with one OTDR LM module
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Endurance

Endurance

Conditions of use Li-Polymer battery

According to Telcordia GR-196-CORE recommendation:

Normal conditons, with normal backlight, 3 acquisition of up to 8 hours
30 seconds per quarter of hour, auto off

Under continuous acquisition, with high screen backlight :
- with an OTDR QUAD Module Up to 3h
- with an OTDR LM Module Up to 3h45

Mains adapters

Standard Mains Adapter

Input 100-250 V, 50-60 Hz

Output 12V DC 2.5 A max

Compliance EN 60950

Supply or Power assigned in AC and in DC: 25 W

Dimensions - Weight

Weight
2000 Platform without options, battery nor module | 692 g 1.52 Ibs

2000 Platform with a Li-Polymer battery and one

OTDR LM Module 1.21kg | 2.67lbs

Li-Polymer battery 172 g 0.37 Ibs
VFL/PWM option 30g 0.066 Ibs
Dimensions (mm) Dimensions (mm)
(HXWXD) (HXWXD)
Bumpers included W/o bumpers
Without module 175 x 138 x 41 169 x 134 x 39
With 1 module 175 x 138 x 80 169 x 134 x 39
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Environment

Environment

Temperature

Humidity

Climatic
pressure
EMI/ESD

Electrical

Safety

Drop test

Shocks

Bumps

72

— Operating temperature range -20°C to +50°C (-4°F to +122°F)

— Operation including all options

(guaranteed specifications) 0710 +40°C (+32°F to +104°F)

— Storage -20°C to +60°C (-4°F to +140°F)

— 5 to 95% without condensation

— Climatic pressure: 4000 meters

— CE class B Compliant (EN61326-1)
— FCC 47-1 Part 15 Compliant

— EN61010-1: 2001 Compliant

In accordance with the Telcordia GR-196-CORE recommendations, the
2000 Platform resists the following test:

— 6 impacts dropped from a height of 1m on a pinwood floor of 5 cm
thickness (1 impact on each of its 6 sides, with power off).

The 2000 Platform resists the following test:

— 3 shocks per axis along each of the 3 axes, with power off.
— Impacts of 15g, 1/2 sine, duration 11 ms, at 10 second intervals.

The 2000 Platform resists the following test:

— 1,000 bumps per axis along each of the 3 axes, with power off.
— Jolts of 15g, 1/2 sine, duration 6 ms, at 1 second intervals.
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Vibration

Flammability

Chapter 9 Technical specifications
Characteristics of the options

The 2000 Platform resists the following vibration tests:

— Complete test comprising 6 cycles along each of the x, y and z axes.

— One cycle of 5 to 200 Hz and back to 5 Hz with a sweep duration of
one minute/octave.

— 3 mm amplitude displacement test, for the range 5 Hz to 15 Hz.
— 3g acceleration test for the range 16 Hz to 200 Hz.

The 2000 Platform housing (in ABS, type VO0) does not propagate fire.

Characteristics of the options

Power meter

option

VFL

Bluetooth
Option

Specifications given for 25°C, after 20 minutes stabilization time and after
zero setting.

— Wavelength range: 800 to 1650 nm in steps of 1 nm

— Calibrated wavelengths: 850 / 1310 / 1490/ 1550 / 1625 nm

— Accuracy at calibrated wavelengths: + 0.2 dB (at -30 dBm)

— Input power range : -60 dBm to +10 dBm

— Maximum resolution: 0.01 dB / 0.01nW

— Measurement range:+5 to -50 dBm (-45 dBm from 800 to 1250 nm)
— Linearity within the measurement range: + 0.2 dB

— Wavelength: 650 nm
— Length of fiber: up to 5 km

— Class 2 laser (standards EN60825-1 and FDA21 CFR Part
1040.10).

Bluetooth Option
— Class 2
— Range: up to 10 meters
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Options and accessories

This chapter shows the references of the options and accessories of the
2000 Platform.

The topics discussed in this chapter are as follows:

“References of options for the 2000 Platform” on page 76
“References of accessories” on page 76

“References of manuals” on page 77

“References of result processing software” on page 77
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References of options for the 2000 Platform

References of options for the 2000 Platform?

Base Unit references Reference
MTS-2000 Handheld Platform with touchscreen EM2000T
T-BERD 2000 Handheld Platform with touchscreen ETB2000T
Power Meter / VFL / Wifi / Bluetooth options Reference
Optical Power Meter option for T-BERD/MTS-2000 Platform E20PM
Power Meter and VFL option for T-BERD/MTS-2000 Platform E20PMVFL
Power Meter and Talkset option for T-BERD/MTS-2000 Platform E20TSPM
Mains options Reference
Cigarette lighter adapter for 2000/4000 Platform E40LIGHTER

References of accessories

Battery Reference

Replaceable Li-Polymer battery (see “Changing the battery” on page 95) E20LIPO

Scope Reference
Digital Videoscopg ki't including FBP-P5000 probe (USB2.0) in a small EDESCOPE5K
soft case, and 7 tips in a box

Carrying Cases References

Hard carrying case for the MTS/T-BERD 2000 and various accessories | E20HCASE1

Large Soft Case for MTS/T-BERD 2000/4000 Platform E40SCASE1

2.These options must be ordered together with the instrument.
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References of manuals

References of manuals

User manual for 2000 Platform Reference
Printed User manual for 2000 Platform (French) E2000M01
Printed User manual for 2000 Platform (English) E2000M02
Printed User manual for 2000 Platform (German) E2000M03

mm NOTE

The User Manuals for MTS/T-BERD 2000 (Platform & Modules) are
available in pdf format, into the unit.

The printed versions of the manuals are available on option, in
French, English and German.

References of result processing software®
Reference
Optical Fiber Trace software EOFS100
Optical Fiber Trace software (5 licences) EOFS1005L
Optical Fiber Trace software (site licence) EOFS100SL
FiberTrace software - update EOFS100UP
Optical Fiber Cable software EOFS200
Optical Fiber Cable software (5 licences) EOFS2005L
Optical Fiber Cable software (site licence) EOFS200SL

3.Free software updates on the Web (but without user manual)
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Maintenance and
Troubleshooting

This chapter describes how to maintain your unit and identify and correct
problems related to the 2000 Platform.

The topics discussed in this chapter are as follows:

— “Maintenance procedure” on page 80

— “Recycling Information” on page 92

— “Troubleshooting” on page 92

— “General information on warranty” on page 97

User Manual 790000002/00 79



Chapter 11 Maintenance and Troubleshooting

Maintenance procedure

Maintenance procedure

80

Cleaning
Cleaning plates

and housings

Cleaning the
screen

Maintenance work on this instrument must only be undertaken
by qualified personnel using suitable equipment.

In most cases, it is advisable to contact the nearest JDSU Service
Centre, which will undertake the appropriate troubleshooting and repair
work.

The performance and technical complexity of the 2000 Platform class
this instrument in a new generation of equipment, for which JDSU has
laid down a maintenance policy based on the principle of standard
module replacement.

In implementation of this policy, we have set up powerful card trouble-
shooting test resources in our factories and a rapid dispatch system
operating between our factories and branches.

Only by this procedure can the high quality of the instrument continue to
be ensured after repair work. This procedure also has the advantage of
reducing repair costs and time.

In the interests of quality and efficiency, we strongly recommend adop-
tion of the following procedure in the event of a fault, before any other
steps are taken:

— Verify that the instrument is plugged in.

— Check the connections of any peripheral equipment to the 2000
Platform.

— If afault is detected, or in case of doubt, it is advisable to contact the
nearest JDSU Service Centre, which will undertake the appropriate
repair work.

The front and rear plates and the housings may become tarnished with
handling. To clean them, use only a rag moistened with soapy water.

Never use any product containing acetone, trichloro-ethylene, benzine or
alcohol, as these will attack the printed markings.

To clean the screen, use an antistatic product.
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Maintenance procedure

Cleaning the — Use a non-linting type of paper, such as Joseph paper, soaked in
optical cable isopropylic alcohol.
connector — Pay particular attention to the polished face of the fiber, rubbing it in
a direction perpendicular to the axis of the fiber.

Cleaning the — Squirt a highly volatile solvent (such as isopropylic alcohol) into the
optical connector.

connections of the — Blow out the connector using a clean dry air supply from an aerosol
2000 Platform can fitted with an extension.

mmmmmw NOTE

If your module has a universal connector, unscrew its adaptor to
access the ferule.

Accessing to On the 2000 Platform, some screens allows to display information on
the 2000 different elements of the equipment.

Platform To display the information on the 2000 Platform

information 1 On the Home page, validate Settings icon to reach the System

Settings page.
2 On the right menu keys, press About to display the presentation
screen of the 2000 Platform.

General page The General page is displayed by default, and allows to display the
presentation screen, with all the information concerning the software
versions, the hardware options and the module installed.

o Alnca B " 1027 oaisoil
[ Garsral
| Sofware Version information Prodect Conbents
- Software |
Optises
- i e
SaTITES

Ciats

Exit

Fig. 42 General page
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Maintenance procedure

This page shows:

— The software version information

— The product contents: base, optical options, battery type, module
installed and date of calibration for options concerned.

The options set into the 2000 Platform are marked with a green tick.

Software options This page allows to visualize the software options available on the 2000
page Platform.

1 Once on the About screen, press Software Options menu key to
display the list of software options available on your 2000 Platform.

e e
General
Loftware Ogfian
OTDA P ERFERT_MM s |
P ENPERT SM Ot
Sareices |
Diata
Bt
-
Fig. 43 Software Options page

Services Data page This page allows to display information about the elements inside the
2000 Platform (CPU, Memory, hardware revision, screen reference...).

1 Once on the About screen, press Services Data menu key to
display the list of elements countained on your 2000 Platform.
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Maintenance procedure
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Fig. 44 Services Data page

Accessing to All documents necessary for the 2000 Platform use are directly available
the 2000 onto the equipment.

Platform To display the list of documents available for 2000 Platform use:

documentation 1 Validate the Help icon on the Home page.

2 Click on Link to PDF User Manual.

3 Inthe new page, click one link to display the corresponding docu-
ment: User manual, Getting Started Manual, Quick Card...

TF el rowser - MTSI000 Halp
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Fig. 45 Help page
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Maintenance procedure

Installing a new

version of the
software

A\
A\

When a new software version is loaded, there is a risk of re-initializa-
tion of the internal memory. Before installing the new software, it is
therefore advisable to save the results in the memory, using the Save
function called up by the FILE button.

Do not interrupt the installation process, as this could damage the
instrument.

To avoid any interruption of the installation procedure, the 2000 Plat-
form must be operating on the mains: if the procedure is started while
operating on battery, a message indicates that the instrument must be
connected to the mains.

Downloading from When the software is obtained from the Internet, it must be saved on a
Internet storage medium before the software upgrade of the product can be

carried out. To do this:

Open Internet Explorer

2 On the JDSU web site (http://www.jdsu.com), open the page of the

product concerned
— MTS 2000 Multiple Services Test Platform
or
— T-BERD 2000 Multiple Services Test Platform

3 Click on the tab Downloads.
4 Click on the link 2000 Firmware Update

A new page opens, displaying the current version available and
several links.

Click on the icon or on the exe file to load the archive.

In the new dialog box displayed, click on Save to save the exe file
on the PC.

Once completed, connect the USB memory stick to the PC and
follow the instructions chapter “Installation from a USB memory
stick” on page 84, from step 2.

Installation from a You must be equipped with a USB memory stick with a minimum capacity
USB memory stick of 128 Mo.

84
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Before installing the upgrade, you must format the USB memaory stick
(see “Formating the USB memory stick onto the 2000 Platform” on
page 94).

1 Once formated, disconnect the USB memory stick from the 2000
Platform using the key Eject USB in the Media Utilities page.

As for any media formatting, please note that all data present on the
& USB memory stick will be irremediably lost.

2 Connect the USB memory stick to the PC

3 Unzip the upgrade files on the PC and transfer it to the USB memory
stick:

a Download and save on your PC the .exe upgrade file that you
can get from the web ( http://www.jdsu.com, see “Downloading
from Internet” on page 84).

b Once the transfer is completed, double click on the .exe file: A
window will appear. Check that the folder is correct i.e. the USB
memory stick driver is appearing in the line at the bottom of the
dialog box then press OK. If not, click on the icon gl in order to
select the right USB drive.

Fig. 46 List of software update

¢ Press OK and wait for the end of loading.

4 Then remove the USB memory stick, using the appropriate proce-
dure, from your PC

5 Insert the memory stick into one of the USB ports on the Platform.

s | NOTE

A bip is emitted each time the USB memory stick is inserted or
removed from the USB port.
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6 Press the HOME button, then successively the Settings > Expert
Tools > Upgrades > Software Upgrade > Upgrade from USB.
The message Are you sure? is displayed

7 Click on Confirm.

The list of the software versions available on the USB stick is
displayed next to the versions installed on the 2000 Platform.

8 Click on Show Prev choice or Show Next Choice to display the
previous and next versions available.

9 Click on Confirm this Choice to start the upgrade of the selected
software(s).

or
Click on Confirm All Choices to upgrade all versions.

mmm NOTE

The software versions list does not always appear (cf previous ver-
sions) as well as the Previous / Next Choice buttons and the Con-
firm/Continue key. In this case, the upgrading starts automatically.

Upgrading begins. The 2000 Platform is automatically rebooted.
Upgrading takes several minutes. Finally, the 2000 Platform is auto-
matically restarted.

push any button or remove the USB memory stick while the
indicator is lit. The USB stick can be removed if necessary once
the Testing indicator is off.

j During the upgrade, the Testing indicator is lit in red. Do not

Installation from Before starting the software upgrade via Ethernet, make sure the IP
Ethernet adress of the PC server.

The update can be performed directly onto the equipment, using an http
address.
Connect the 2000 Platform to a PC via an Ethernet link.

2 On the Home page, press Settings key to open the System
Settings page.

3 Inl/O Interfaces, on the line Ethernet, select Mode: Dynamic.
4 In the Upgrade Server box:
— On the line Address Type, select Server name

— On the line Server Name, enter the address:
2k.updatemyunit.net
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Upgrade Server
Address Type Server Name
Server Name 2k.updatemyu... 2k.updatemyunit.net

Fig. 47 Configuration of the Upgrade Server

5 In the l/O Interfaces box::

— On the line Use proxy, select No, Manual or Auto wether a
proxy is used or not.

6 Once completed, press Exit to return to the Home page.

7 Press, in succession, Expert Tools > Upgrades > Software
Upgrade > Upgrade via Ethernet.
The message Verify IP address of PC server appears.
8 Click on Continue.
The list of the software versions available on the PC is displayed
next to the versions installed on the 2000 Platform.
9 Click on Show Prev choice or Show Next Choice to display the
previous and next versions available.

10 Click on Confirm to start the upgrade of the selected software(s).
or
Click on Confirm All Choices to upgrade all versions.

mmm NOTE

The software versions list does not always appear (cf previous ver-
sions) as well as the Show Previous / Next Choice buttons and the
Confirm/Continue key. In this case, the upgrading starts automati-
cally.

Upgrading begins. The 2000 Platform is automatically rebooted.
Upgrading takes several minutes. At the end, the 2000 Platform is
automatically restarted.

During the upgrade, the Testing indicator is lit in red. Do not
& push any button while the indicator is lit.

Upgrading from This method is used to make a complete reinstallation of the software
the boot versions.

1 Turn off the 2000 Platform using the ON/OFF button, keeping the
equipment connected to the mains.
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Maintenance procedure

A\

2

Insert the USB stick onto which the software versions are stored into
one of the USB port of the Platform

Press simultaneously SETUP + START/STOP buttons

Maintaining the two buttons pressed, press ON button to start the
2000 Platform.

A menu is displayed, then the screen allows to select Upgrade from
from USB

After a few seconds, a new page displays indicating that to continue

the reboot, the validan key must be pressed.
Press the hard key

The reboot starts automatically.

The Testing indicator will be lit in red during upgrade. Do not
push any key or remove the USB memory stick until the lit turns
off.

Once the upgrade is completed, the 2000 Platform will automatically
tunrs on and display the Home page.

Install Option This page allows to import the licence to get a software option.

88
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Fig. 48 Example of a License file (.lic)
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To import the license, you can either enter manually the licence code,

given in the license file, (.lic file) or import this file with a USB memory
stick connected to the 2000 Platform.

It is strongly recommended to perform the installation using the
A importation of Licence via a USB memory stick.

Enter Manually the 1 In the Home page, click on Expert Tools > Upgrades > Install
Licence Option > Enter License

The edition keypad is displayed

2 Enter the challenge code of the option, set at the bottom of the file
(see Figure 48 on page 88),

e Sefmare Optisas licenss

= ke
| | Arziace

Flsasn el your oplion Chalkings tode

1
i . B . e

Fig. 49 Enter the Licence code

such as Word...

The challenge code must be entered exactly as it is in the .lic file,
paying attention to the lower-case and upper-case letters etc.

j The license file can be opened via a word processing software

3 Press the Enter key to validate the code
Your software options will be installed

At the end of this sequence you will be asked to reboot the unit to
apply the modifications, pushing the key #sat | Confirm the reboot
to restart the Platform. %]

Import the license 1 In the Home page, select the Settings icon

from the USB 2 |n the System Settings page, press Expert Tools > Upgrades >
memory stick Install Option > Import License
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If the USB memory stick is not already connected to the Platform, a
message asking the memory stick insertion is displayed. Confirm it
once the stick is connected.

3 Inthe File Explorer, select the USB stick, then the license file (.lic) to
be imported,

4 Click on Load > Confirm

5 The challenge codes contained in this file will then be loaded auto-
matically and your software options will be installed.

imgart foftmer e Colam ense |:|- ;

Fig. 50 License imported

6 At the end of this sequence you will be asked to reboot the unit to
apply the modifications, pushing the key fetcat .

7 Confirm the reboot Q

Locking the The 2000 Piatform can be locked at any time:

2000 Platform 1 In the HOME page, click on Expert Tools
2 Click on Instrument Lock Out

3 Confirm the 2000 Platform locking by clicking on Confirm (or use
the Cancel key to cancel the process).

The numeric keypad is displayed

4 Entrer the password to lock the instrument: 42000 with the numeric
keypad displayed.
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5 Click on Enter
The 2000 Platform locking screen is displayed.

| i Lock-ut activated L T L R 1 ]

A
|9
LOCKED

This Instrument has been locked
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Fig. 52 Locking screen

Click on the Notepad Message key to add a message using the text
edition.

Unlocking the 2000 Platform
1 Once the locking screen is displayed, click on the key Unlock
Instrument.

2 Press confirm to confirm the Platform must be unlocked.

3 Enter the password 42000 using the numeric keypad displayed and
validate.

The screen automatically displays the HOME page.
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Returning dN  When returning an instrument, it is essential to indicate the following
instrument Minimum information:

— the type and serial number of the instrument (on the identification
label) and the configuration code (under the bar code)

— adescription of the fault found on the instrument.

The returned instrument will then be repaired and calibrated.

Guarantee Any repair operation supervening within the guarantee period of the

conditions instrument will be carried out at the expense of JDSU. However, for any
sub-assembly upon which work has been carried out otherwise than by
JDSU Service Centers, the cost of a replacement sub-assembly will be
invoiced.

Recycling Information

JDSU recommends that customers dispose of their instruments and
peripherals in an environnmentally sound manner. Potential methods
include reuse of parts or whole products and recycling of products
components, and/or materials.

Waste Electrical and electronic Equipment (WEEE) Directive

In the European Union, this label indicates that this product should not
be disposed of with household waste. |l should be deposited at an appro-
_—— priate facility to enable recovery and recycling.

Troubleshooting

Interpreting

alarms
Troubleshooting Solution
Nothing happens when the ON/ - Make sure that the battery is present or charged; or
OFF key is pressed. the mains adapter is properly connected (see “Con-

necting the mains adapter” on page 16).
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Troubleshooting

Solution

Nothing happens on screen,
whatever is the action done
(menu key or hard key pressed...)

You are using the 2000 Platform
in the ordinary way when it sud-
denly switches off.

The battery refuses to charge (the
Charge indicator does not go on
when the instrument is connected

to the mains and is not operating).

When using the touchscreen,
nothing happens

Error message when USB has
been disconencted

No beep is emitted when the USB
memory stick is connected

Error message when upgrade via
Ethernet is confirmed

Error message when upgrade via
USB key is confirmed

Error message when unlocking
the instrument

- The Platform must be rebooted.
See “Resetting the 2000 Platform” on page 18.

- Check the instrument is not configured to Auto off.
See “Defining the Automatic shutdown of the 2000
Platform” on page 24).

- Check the battery charge level.

See “Charging the battery” on page 16.

- There is no battery in the instrument.

- The temperature level of the equipment does not
allow the battery charging for safety reasons. Wait
the equipment cools down.

- The battery needs to be changed.

See “Changing the battery” on page 95.

- The touchscreen needs to be calibrate.
See “Touchscreen calibration” on page 94

- The USB disconnection has not been done prop-
erly (see “USB memory stick disconnection” on
page 60)

- The data transfer was not completed when USB
key was disconnected.

- A previous USB memory stick has not been prop-
erly disconnected (see “USB memory stick discon-
nection” on page 60).

- The USB memory stick is not detected by the 2000
Platform: use another memory stick, or another
sotrage media; or transfer data via USB cable (see
“Transferring files to a PC” on page 50).

- Check the Server Name is correctly entered (see
“Installation from Ethernet” on page 86)

Check the USB key is correctly connected (see
“USB memory stick connection” on page 60)

- The password is not the correct one (see “Locking
the 2000 Platform” on page 90).
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94

Formating the

If the USB icon L\ is displayed on the upper banner of the screen,

USB memory when a USB memory stick is connected to the 2000 Platform, this may

stick onto the

means the memory stick must be formatted.

2000 Platform !f the stick needs to be formatted, proceed as follows:

1

4

5

Insert the memory stick into one of the USB port on the top of the
2000 Platform.

Press the HOME button
Validate the Settings icon to open the System Settings page.

On the right menu keys, successively select Expert tools > Media
utilities > Usbflash Format.

Confirm your choice to actually format the USB memory stick.

the USB memory stick will be irremediably lost.

j As for any media formatting, please note that all data present on

Erase disk To delete all the disk contents of the 2000 Platform:

1

On the Home page, Press twice the Settings icon to open the
System Settings page
Press Expert Tools > Media Utilities,

Select Erase Disk to delete all the disk contents into the 2000 Plat-
form.

A confirmation must be validated before the deletion.

Touchscreen I you meet problems when using the touchscreen (example: pressing on
calibration 2anicon does notwork correctly...) a calibration can be performed on the
2000 Platform touchscreen.

To calibrate the touchscreen, proceed as follows:

A ON =

o O

Push the HOME button

Press twice the Settings icon to open the System Settings page.
Press Expert Tools menu key

Press Touchscreen Calibration key

A blue slightly smaller screen appears, displaying a little target on
the left hand corner .

Click on this target (preferably with the touchscreen pen).

A new target appears then and again, for a total of 4 times, in order
to click on all corners of the screen.
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If all the targets are not correctly touched, the touchscreen cannot be
used. Otherwise, the touchscreen may be used directly.

Target

Fig. 53 Touchscreen calibration

Changing the i you meet problems during the Platform functioning, or if the battery
battery does not charge anymore when plugged, this may require the battery to
be replaced.

CAUTION
A Battery is not interchangeable in the field. It must be replaced

exclusively for maintenance purpose.

Accessing to the To access the battery of the 2000 Platform, proceed as follows:

damaged battery 1 Switch off the instrument and disconnect the mains supply.

2 Turn the instrument face down on the work surface.

3 If any, remove the module installed (see “Removing a module” on
page 14).

4 Remove the battery door

5 Pull the battery connector from its housing, to disconnect it from the
base, taking care not to damage the connector into which it is
plugged.
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Battery door

Fig. 54 Battery installation

Date and Time parameters will be lost when battery is
A diconnected.

Installing anew 1 Set the battery into the Platform

battery 2 Connect the new battery in the connector of the 2000 Platform, in
the right way using the location notch.

Fig. 55 Setting a new battery
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When putting a battery back into its seating, make sure that its
connector engages correctly with the one of the base and that
the door is correctly closed.

Contact JDSU local Sales Service to get a new battery.

Do not use any battery other than the one supplied with the
instrument, or supplied by JDSU.

General information on warranty

Hardware
Warranty

The warranties described herein shall apply to all commercially available
JDSU products. Any additional or different warranties shall apply only if
agreed to by JDSU in writing. These warranties are not transferable
without the express written consent of JDSU.

JDSU warrants that Hardware Product sold to customer shall, under
normal use and service, be free from defects in materials and workman-
ship. Information regarding the specific warranty period for this product
can be obtained by contacting your local JDSU Customer Service Repre-
sentative, or at our web site www.jdsu.com. If installation services have
been ordered, the warranty period shall begin on the earlier of (1)
completion of installation, or (2) thirty (30) days after shipment to
customer. If Installation Services have not been ordered, the warranty
period shall begin upon shipment to Customer. Hereafter these periods
of time shall be collectively referred to as the Initial Warranty Period.

JDSU ’s obligation and customer’s sole remedy under this Hardware
Warranty is limited to the repair or replacement, at Acterna’s option, of
the defective product. JDSU shall have no obligation to remedy any such
defect if it can be shown: (a) that the Product was altered, repaired, or
reworked by any party other than JDSU without JDSU’s written consent;
(b) that such defects were the result of customer’s improper storage,
mishandling, abuse, or misuse of Product; (c) that such defects were the
result of customer’s use of Product in conjunction with equipment elec-
tronically or mechanically incompatible or of an inferior quality; or (d) that
the defect was the result of damage by fire, explosion, power failure, or
any act of nature.
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Warranty
disclaimer

JDSU performed repairs shall be warranted from defective material and
workmanship for a period of ninety (90) days, or until the end of the Initial
Warranty Period, whichever is longer. Risk of loss or damage to Product
returned to JDSU for repair or replacement shall be borne by customer
until delivery to JDSU.

Upon delivery of such product, JDSU shall assume the risk of loss or
damage until that time that the product being repaired or replaced is
returned and delivered to customer. Customer shall pay all transportation
costs for equipment or software shipped to JDSU for repair or replace-
ment. JDSU shall pay all transportation costs associated with returning
repaired or replaced product to customer.

For hardware and/or services furnished by JDSU, the foregoing warran-
ties are in lieu of all other warrantees and conditions, express or implied.
JDSU specifically disclaims all other warranties, either express or
implied, on any hardware, documentation or services including but not
limited to warranties relating to quality, performance, noninfringement,
merchantability or fitness for a particular purpose, as well as those arising
from any course of dealing, usage or trade practice. under no circum-
stances will JDSU be liable for any indirect or consequential damages
related to breach of this warranty.
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